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1 Introducing UNICORN System Control

1 Introducing UNICORN System
Control

About this chapter

This chapter contains:
e Ageneral introduction to System Control using the UNICORN software.

¢ Information about the user documentation for UNICORN, including an overview of
related documents describing the use of the software.

Software declaration of
conformity
UNICORN 6.4 is technically compatible with all relevant sections of FDA 21 CFR Part 11.

A part 11-system assessment checklist is available on request from your local GE repre-
sentative.

In this chapter

This chapter contains the following sections:

Section See page
1.1 About this manual 6
1.2 About System Control of UNICORN 7
1.3 Important user information 8
1.4 Associated documentation 9
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1 Introducing UNICORN System Control
1.1 About this manual

1.1 About this manual

Purpose of this manual

The purpose of the UNICORN System Control Manual is to provide a guide describing
the general system control functions in UNICORN. It includes general operation, system
settings and instructions on how to perform a chromatography run. It covers the features
and tools included in the System Control module of the UNICORN software with practical
instructions.

The manual covers the following:
¢ general UNICORN operation, including log on and log off.
* how to perform arun

¢ how to change system settings.

Refer to the instrument's Operating Instructions for further information on how to perform
arun.

Note: The UNICORN System Control Manual does not describe the functions of every
command in all panes and dialogs of the user interface. Refer to the online
help for information about commands that are not described in this manual.
The online help in the System Control module is accessed either by clicking
help buttons in software dialogs, by pressing the F1 key, or selecting Help:Help
for System Control.

Typographical conventions

Menu commands, field names and other text items from the software are quoted exactly
as they appear on the screen, in a bold italic typeface:

Example: Method Navigator

Controls on the instrument, computer or keyboard keys are shown with a bold, regular
typeface:

Example: Press the Delete key.

Text that the user must either type exactly as shown in the manual, or that UNICORN
displays as a response (not a regular part of the graphic user interface), is represented
by a monospaced typeface within quotation marks:

Example: "Connection change"
File system paths are represented by a monospaced typeface:

Example: C:\Program Files\GE Healthcare\UNICORN\
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1 Introducing UNICORN System Control
1.2 About System Control of UNICORN

1.2 About System Control of UNICORN

Introduction

This section is a brief introduction to the control system used in UNICORN.

What is UNICORN?
UNICORN is a complete software package for:
e control and supervision of chromatography systems.

e evaluation and analysis of the results from separation runs.

Description of the System
Control module

The System Control module is used to start, monitor and control a chromatography run.
Runs can be performed in three different ways, as listed below:

e Using a preprogrammed method without any manual interactions.
e Interact with the instrument during a method run by performing manual instructions.

e Perform manual runs. This approach may be useful for simpler procedures such as
priming tubing with buffer.
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1 Introducing UNICORN System Control
1.3 Important user information

1.3 Important user information

Read this before running System
Control

All users must read the entire Operating Instructions before installing, operating or
maintaining the chromatograpy system, and running System Control.

Always keep the Operating Instructions at hand when operating System Control.

Do not operate the chromatograpy system in any other way than described in the user
documentation. If you do, you may be exposed to hazards that can lead to personal injury
and you may cause damage to the equipment.
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1 Introducing UNICORN System Control
1.4 Associated documentation

1.4  Associated documentation

Introduction

This section describes the user documentation that is delivered with UNICORN.

User documentation

The user documentation listed in the table below is available from the Help menu in
UNICORN and as printed books.

Document ‘ Main contents

UNICORN Method Manual | Overview and detailed descriptions of the method cre-
ation features in UNICORN. Instructions on how to use
the software. Workflow descriptions for common opera-

tions.
UNICORN Evaluation Overview and detailed descriptions of the evaluation
Manual features in UNICORN. Instructions on how to use the

software. Workflow descriptions for common operations.

UNICORN Administration | Overview and detailed description of network setup and
and Technical Manual complete software installation. Administration of
UNICORN and the UNICORN database.

UNICORN System Control | Overview and detailed description of the system control
Manual features in UNICORN. Includes general operation, system
settings and instructions on how to perform a run.

UNICORN Online Help Dialog descriptions for UNICORN (from the Help menu).
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2 General UNICORN operation

2 General UNICORN operation

About this chapter

This chapter includes a description of general UNICORN operation which includes log
on and log off UNICORN, how to structure files and folders and how to use the Online
Help.

In this chapter

This chapter contains the following sections:

Section See page
2.1 Log on and log off routines 11
2.2 Help functions 13
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2 General UNICORN operation
2.1 Log on and log off routines

2.1  Logon and log off routines

Start UNICORN and log on

Follow the instructions below to start UNICORN and log on to the program. A valid
e-license must be available for the workstation. See UNICORN Administration and
Technical Manual for more information about e-licenses.

Step Action

1 Double-click the UNICORN icon on the desktop.
Result: The Log On dialog opens.

Note:

Ifthere is no connection to the database it is still possible to log on to UNICORN
and control a running system. The Log On dialog will give the option to start
System Control without a database. Click Start System Control to proceed
to the next Log On dialog.

2 In the Log On dialog:

e select User Name.
and

e enter Password.
Note:

It is also possible to select the Use Windows Authentication checkbox
and enter a network ID in the User Name field.

41l Log On - UNICORN (=]

[ Use Windows Authentication

User Name: [ Defaul -

Password: |

Domain

Access | Administrators '\
Group:
(@) [ ok ][ Cencel || Oplions>> |

¢ click the Options button, and select which UNICORN modules to start.

Start: V] Administration [] System Control
[¥] Methad Editor [¥] Evaluation
@ [ (o] 4 J I Cancel | { Options <<
e click OK.

Result: The selected UNICORN modules open.
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2 General UNICORN operation
2.1 Log on and log off routines

Log off or exit UNICORN

Follow the instruction below to log off or exit UNICORN. This can be performed from any
of the UNICORN modules.

If you want to... then... ‘
log off UNICORN on the File menu, click Log off.
|¢; Log off - Eric %
Exit UNICORM

Result: All open UNICORN modules close and the Log On
dialog opens.

exit UNICORN on the File menu, Exit UNICORN.

+4 Log off - Eric

| Exit UMICORN [},

Result: All open UNICORN modules close.

Note: If an edited method or result is open and not saved when you try to exit or log
off UNICORN, you will see a warning. Click Yes to save, No to exit without
saving, or Cancel to stay logged on.

Method Editor

] : Do vou wank to save the changes made to Method 17
.

[ Yes J[ Mo ][ Cancel ]
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2 General UNICORN operation
2.2 Help functions

2.2 Help functions

Default installation folders

The default path to the program files folder where UNICORN is installed in a 32-bit instal-
lation of Windows®© 7 is C:\Program Files. The default path to the folder where
UNICORN is installed in a 64-bit installation of Windows 7is C: \Program Files (x86).

In this manual the file path to the installation folder is shown as follows:
Example: Program Files Path\GE Healthcare\UNICORN\

Replace Program Files Path with the correct path for your version of Windows.

The help viewer application

As part of the UNICORN software installation, a special viewer for the online help will be
installed. This application, the MadCap™ Help Viewer, is accessed from the UNICORN
user interface either by clicking help buttons in dialogs, by pressing the F1 key or by
clicking Help menu items.

By default, this application will place a shortcut icon on the desktop. If you cannot log
on to UNICORN, you can open the online help using this shortcut.

To start the UNICORN online help:

Step Action

1 Double-click the shortcut icon.

2 On the File menu, click Open.

3 Browse to the folder Program Files Path\GE Healthcare\UNI-
CORN\UNICORN 6.4\Documentation\Help\Chromatography

4 Select the file Manual .mchelp.

5 Click the Open button.

Result: The online help portal page opens.
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2 General UNICORN operation

2.2 Help functions

14

Note:

Sometimes Windows may need to register the MadCap Help Viewer as the
application for files of the type .mchelp before it will recognize calls from help
buttons in UNICORN 6.4. If that happens, you may need to open the viewer
manually as described above. It should only be necessary to do this once for
a new Windows user profile.
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3 The System Control module

3 The System Control module

About this chapter

This chapter gives an overview of the System Control module.
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3 The System Control module
3.1 System Control module overview

3.1  System Control module overview

lllustration of the System Control
user interface

The illustration below shows the different panes and areas of the System Control module.
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Part Description ‘
1 Run Data: Presents current run data values.
2 Chromatogram: |llustrates data as curves.
3 Process picture: lllustrates the current flow path.
4 Status bar: Shows information on instrument and database connection.
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3 The System Control module
3.1 System Control module overview

Select panes to display
The following instruction describes how to display panes:

Step Action

1 On the View menu.

2 Select which panes to display.

Wiew | Manual  System  Tools  Help
[¥] rookar
[v] ststusar

[] wethod Havigator

Fraction Collector Content

E Run Data

[¥] chromatogram
[¥] Fowscheme
Z[ fun Log

Restare to Default

' Refresh F5
i

| Documentation...

Result: Selected panes will be displayed on the screen. The Method Navigator
with folders and methods will be displayed at the left side.

Instrument states

Information about the status of instrument connections and chromatography runs are
displayed as states. The different states are displayed in the System Control module in
Run Data and in the Status bar.
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4 How to perform arun

4 How to perform arun

About this chapter

This chapterincludes a description of how to use the System Control module to connect
to a system and how to perform and monitor a run.

In this chapter

This chapter contains the following sections:

Section See page
4.1 Connect to system 19
4.2 Start a method run 21
4.3 Monitor a run 26
4.4 Manual system control 34
4.5 Method queue, Design of Experiments, Scouting and BufferPro 37
runs
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4 How to perform a run
4.1 Connect to system

4.1  Connect to system

Connectinstrumentto UNICORN

Follow the instruction below to connect the instrument to UNICORN.

Step Action

1 In the System Control module,

o click the Connect to Systems button,

« onthe System menu, click Connect to Systems.

or

Result: The Connect to Systems dialog opens.

Connected spstems (1 selected, max 3]

System hame Control ~ Wiew

[ B Swstemi
] B System2
(E Swstem3 @ ]
i . Spstemd
[ B Spstemb
[ B Swstems
] B Swstem?
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4 How to perform arun
4.1 Connect to system

Step Action

2 In the Connect to systems dialog:
e Select a system by selecting the check box in front of the name.

- To control the selected system, click the Control option button.

- Toviewrunson the selected system, controlled by another user, click
the View option button.

e Click OK.

Note:

Instruments that are turned off or disconnected from the network appear
dimmed and cannot be connected.

Tip:
To view the users currently connected to systems, either in control or view
mode, click the Connected Users button.

Result: UNICORN states Connection = Connected in control or Connection
= Connected in view in the status bar in the lower part of the System Control
window.

| Connection = Connected in contral [
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4 How to perform a run
4.2 Start a method run

4.2  Start a method run

Select a method to run

Step Action

1 In the Method Navigator pane in System Control, select the method to run.

L,.‘_“' \:? Methods, Methad Qu = ?IE"

| Folder name Syskem v
= ';_—__".- Eric
= |:_: Methods
ﬁj Desalting System3
[ cIEx_Method System3
[ [t method Systems
2 o click the Run button in the toolbar,

%3 System Control

File: : Edit k View Manual  System  Tools  Help
e e

or

e onthe File menu click Run.
Result:

o If a Start Protocol was chosen when the method was created, the first
dialog of the Start Protocol opens. Default is Result Name and Location.

« If no Start Protocol has been chosen, the Select Columns dialog opens.

e If Column type Any was chosen in the Method Settings phase, the Select
Columns dialog does not open and the run starts immediately.

¢ If Column Logbook is not activated the Select Columns dialog does not
open and the run starts immediately.
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4 How to perform arun
4.2 Start a method run

The Start protocol

The table below describes the different dialogs of the Start Protocol that can be selected
in the Method Settings phase when a method is created. Some dialogs are system

22

specific.

Dialog

Fraction collector

Description ‘

Displays the Fraction collector setup; tube type and posi-
tion.

Variable List

Displays a list of all method variables and allows changing
of variable values.

Scouting

Displays a list of all scouting parameters and allows:
e Changing of parameter values.
¢ Inserting or removing scouting parameters.

e Inserting or removing scouting runs.

Text instructions

Displays the text instructions of the method

Notes

e Astart notes tab allows adding of free text.

e A method notes tab allows viewing of text added at
method creation.

Note:

Run and Evaluation Notes will be available for adding of
free text during method run and evaluation respectively.
All notes will be present in the documentation in Evaluation.

Gradient

Displays the gradient programmed for the method. The
X-axis shows the theoretical duration of the method.

BufferPro

Displays Q-inlet positions, used for BufferPro, and descrip-
tions for preparation of stock solutions included in the
selected BufferPro recipe.

Column

Displays the column type chosen for the method as well
as column run parameters and ordering information.
Note:

To get information about the chosen column position, see
Variable List.
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4 How to perform a run
4.2 Start a method run

Dialog Description

Evaluation

Displays a list of available evaluation procedures. Selected
procedures will be run at the end of the method run. The
selected evaluation procedures may be edited from this
list. See UNICORN Evaluation Manual for more information.

Method information

« A properties tab displays information about creation
and modification of the method: dates and users.

¢ A method duration tab displays information about
approximate run time and volume.

« Asignature tab displays information about method
signatures, if applicable.

System Settings

Displays a list of current system settings.

Calibration

Displays a list of the latest performed calibrations.

Questions

Displays predefined questions and reminders.

Note:

Questions are defined when the method is created in the
Method Editor.

Changeable Batch ID

Allows the user to change the Batch ID.

Note:
The Batch ID is displayed in the beginning of the run log.

Result Name and
Location

Displays run info, result location and name. Allows:

e Changing result location by using the browser.

« Changing name of Design of Experiment or Scouting
directory.

e Changing of result name.

Navigate in the Start protocol

Step Action

1 Make the necessary changes in the displayed dialog.

2 To proceed to next dialog, click Next.

UNICORN 6.4 System Control Manual 29-0659-81 AB
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4 How to perform arun
4.2 Start a method run

Step Action

3 In the last displayed dialog in the start protocol, click Start.
Result: The Select Columns dialog opens.

Note:

If Column Logbook is not activated or column type Any was chosen in the
Method Settings phase, the run starts immediately.

Column handling and method

start

24

The instruction below assumes that:
* Column Logbook is activated.
¢ A Column type has been selected when the method was created.

¢ Avalid column license is used.
To register a column, see UNICORN Method Manual.

Step Action

1 Click Start on the last page of the Start Protocol.
Result: The Select Columns dialog opens.

Select Columns - System3 @

Enter or select a column individual
Code lat Exp. I

@ Enter D [ = - N I - 1] ([ x|

O Select ID 5 9286-1 3 12346678 000000 05, HiPrep 25 New..

() Disable columm logging far this run

[[] Apply to all methods with the same column type

Methads Remark Column Barcods Column type

Colurmn Handling Scotting run 1
Column Handing Scouting fun 2 HiPrep 26410 Desalling
Column Handling Scouting run 3 HiPrep 26/10 Desalting
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4 How to perform a run
4.2 Start a method run

Step Action

2 Select or enter a column ID according to one of the following options.

If you want to... ‘ then...

select a column from | select Select ID and select the column to be
a list used from the list.

entercolumnIDmanu- | select Enter ID and manually enter the column
ally code in the Code box.

entercolumnIDusing | o select Enter ID

the 2D Barcode scan-
ner o make sure the cursor is in the first position

of the Code box of the dialog.

¢ point the Barcode scanner towards the
data matrix tag on the column.

« pressand hold the trigger to create a beam.

« when the Barcode scanner beeps, the col-
umn ID is registered and displayed in the
dialog box.

4

=

T

3 Click OK.

Result: The run starts.
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4 How to perform arun

4.3 Monitor arun

4.3  Monitor arun

Introduction

Pump wash

This section describes the data shown in System Control during a run, and the procedure
to customize the view of the different panes. It also describes how to enable alarm and
error notifications.

You can follow the ongoing method run in the System Control module.

e The current system state is shown in the System state box in the Run Data pane.
For example, it may state Method Run, Wash or Hold.

* Selected curves are shown in the Chromatogram pane.

* The current flow path is shown in the Process Picture pane.

To find an overview of the System Control user interface, see Section 3.1 System Control
module overview, on page 16.

Note: Ifa pump wash is included in the method and an Alarm and Error state occurs,
click Continue twice to return to Run state.

Open the Customize dialog

26

To customize displayed information and data in the different panes:

¢ Click the Customize button in the Tool bar.

or

* Right-click in the different panes (except Process Picture) and click Customize.
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4 How to perform a run
4.3 Monitor a run

Result: The Customize dialog is opened.

Customize - System5

x

Run Data Groups | Fur Data Color | Curves | Curve Styleand Color | ®edwis | eiwis | Runlog |

[¥] Rundata

[w] Spstem state -~ Mew Group...

[l Acc. volume

[l Block volume

¥l Acc. time
bl Block fime
¥l Scouting no.:

[ System fow

[ System pressure

OConcB

[ Sample flaw

[ Sample pressure

O PreC pressure

[ DeltaC pressure

[ PostC pressure

O

Ouy 2 =

O3

O pH

O BufferPra pH
[ Cone 21

[ Canc 02

O Conc Q3

[ Canc 04

O Cond

[ % Cond

[

€]

[ 0K J[ Canhcel ]

Note: Further information about the settings in the Customize dialog can be found
in the Online Help.

Customize Run data

Tab in Customize

dialog

Run Data Groups

Customization

Selects which run data to display in the Run Data pane.

Run Data Groups but-
tons:

o New Group
e Edit Group

o Delete Group

Standardize displayed run data by creating run data
groups.

Run Data Color

Changes color of displayed data.
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4.3 Monitor a run

Customize Chromatogram

Tab in Customize

(o [Te][oe}

Curves

Customization

Chooses curves to be displayed.

Curve style and color

Customizes the appearance of the displayed curves.

X-axis

Chooses base unit (time or volume) and set axis scale.

Y-axis

Sets scale for the different curves and select which axes
to display.

Customize Run Log

The Run Log pane displays registered actions during the run.

Tab in Customize

(o [Te][oe}

Run Log

Customization

Selects what to display in the log.

Note:

Allinformation in the run log is saved. The selections define
what is displayed.

Customize - System5 @

| BunData Groups | FunData Color | Cuves | CurveStdeandColor | Made | Yhws | Funlog |

Autoseroll

Included enfry types Included fesdback types:

Set Mark Issusd
Block Stait [] Procsssing
Alams, Warnings and Enars 7] Completed
Method Failed
Manual Ignared
System Cancelled

€]
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Select and zoom a curve in the
chromatogram

4 How to perform a run
4.3 Monitor a run

The following instructions shows how to select a curve and to zoom in the chromatogram.

Command Instruction

Select a curve o

Position the mouse marker over a curve name:

The curve line becomes bold to faciliate the identifica-
tion of desired curve.

Click the curve:

The corresponding legend text is shown in bold type
and the Y-axis scale changes to the unit applicable
for the curve.

Zoom

Click and hold the left mouse button with the pointer
positioned in the top left corner of the area you want
to zoom in on.

Drag the pointer downwards and to the right. A dotted
rectangle marks the selected area. Select the area
you want to zoom in on, and release the left mouse
button.

(The text Zoomed mode is shown in the chro-
matogram)

To reset zoom, right-click and click Reset zoom.

To reset the last zoom action, right-click and click
Undo zoom.

Right-click menu op- o
tions

Right-click and click options and actions. See Online
Help for information.

The Process Picture pane

The Process Picture pane shows the current flow path during the run. Color indication
is applied and real-time data from monitors are shown.

The following illustrations show three examples of process pictures.

UNICORN 6.4 System Control Manual 29-0659-81 AB
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4.3 Monitor a run
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4 How to perform a run
4.3 Monitor a run

SyP to Col
Syr to Loop to W

Column: 1

PreC: 0.00 MPa

DeltaC: 0.00 MPa

Uy 1: 0.27 mAlU

Cond: p_00 mS/cm

pH: 0.00

InletB:B 1

The following table describes how color indicates used flow paths.

Color Indication

Green | Open flow path

Gray Closed flow path
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4 How to perform arun

4.3 Monitor arun

Actions in the Process Picture pane

For some systems it is possible to interact with the Process Picture pane.

To open a related instruction, click or double-click on the component depending on
the system. For some systems a pop-up toolbar is shown. Instructions can be given
from the pop-up toolbar of each component.

. Injection valve X

Manual load System pump waste
Inject Sample pump load
Direct inject Sample pump waste

To find associated instructions for the component, right-click on the component and
click Instructions.

To display a detailed picture with explanations, for example for a valve, right-click
on the component and click Show Details or Detailed picture depending on the
system.

See Perform manual instructions during a method run, on page 35 for more information.

Alarm, warning and error

notification

32

Alarms, warnings and errors might be displayed during the run. For more information
see Error messages and alarms, on page 47.

If an alarm, a warning or an error occurs during the run, it is possible to get a notification
sent to a specified e-mail address.

Note: This e-mail address setting is only for alarms, warnings and errors and differs

from the e-mail address settings made in the Administration module.

Follow the instructions to enable notifications for alarms, warnings and errors.

Step Action

1

In the System Control module, on the System menu, click Notification Set-
tings.

Result: The Notification Settings dialog opens.
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4 How to perform a run
4.3 Monitor a run

Step Action
¢ Typeinthe e-mail addressin the Send e-mails to field. Separate multiple
addresses with a semicolon.

e Select for which occurrences notifications should be sent in the Notifi-
cation on check boxes.

o Click Test Notification E-mail to test if the e-mail settings are correct.

Motification Settings EJ

Send e-mails to: [

Exampla: aperafonSacme comaaminSacma comt

Natification on: [] &lam [] wiaming [] Erar

E-mall account settings are manaaed in Administration/E-mail Setup.
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4.4  Manual system control

The toolbar

34

To hold, pause, continue or end a run, use the buttons in the tool bar.

The following table describes the function of these buttons.

Button ‘ Function ‘

Hold

il

Suspends the execution of the method, while liquid is still pumped at
the current flow rate and eluent concentration.

Pause

£l

Suspends the execution of the method and stops all pumps.

Continue | Resumes a held or paused run.
If the system is in the state Wash, or when Alarms and Errors have
™ | been acknowledged, the system returns to the previous state.
e
End Terminates the run.
sl
Run Starts a new method run, selected in the method navigator.

If a another method run is ongoing, a method queue will be created and
the new run will start when the ongoing run has ended.
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4.4 Manual system control

Manual Instructions
To open the Manual Instructions dialog, use one of these options:

¢ Onthe Manual menu, click Execute Manual Instructions.
or

Click or double-click on a component in the Process Picture (only available for some

systems).
5.998 : 53.0 prec 0,31 s 0551 me 37.12 ms/em 7.83
fow 0.000 " o 0.13 mea

Manual load |~ By-pass

\ - — mrﬂ\- iR

. o
A 1 — v e nd mm Rertristor gyl pra j“‘*‘ 24
/ o P o
mm Bl = 8 g Sp
== Buffer == 5 -
or

* Double-click the arrows beside a selected data in the Run Data pane.

@ System 5 - Method 2
~Run Data

System state Acc. volume Block volume
Method Run 473 ml 2,50 ml

DeltaC pressure >> UV 1_280 >> Cond >>
0.01 MPa 0157 mal .83 mSem

Acc. time Iﬁocknime
4.52min 250 min
Column position >> Iﬁullet >>
1 Frac

Scoutingno.:
[

System flow >>
1.000 ml/min
InletB 3> ‘

InletA >3
A1

Note: For some systems it is possible to open the most relevant instruction by clicking
or double-clicking on a component in the Process Picture or in the Run Data
pane. By right-clicking, there is an option to select one instruction from a group
of instructions associated with the component.

Perform manual instructions
during a method run

The following instruction is an example of how to manually interact with an ongoing
method run. The example shows how to increase the system flow.

Step Action

1 Open the Manual Instruction dialog according to the above instruction.

2 In the Instructions list, select instruction group Pumps and pressures and
instruction System flow.
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4.4 Manual system control

Step

3

Action

Enter a new Flow rate value.

Marrial fmsteiction - System 4

PR =
FHAE 5 Instoa ten ercaer ot
‘wramesters for Syiem fom
e i
‘Sarncha firs am fmimn [ Flow
Gtk Presuas contisl
Purng wath
Syttem wigeh LE 2
Custmrury stst coremmnters
Ouatmresy gacert
EudierFio pH
Cehan paching sy
paih
o Wonlos @
S et Ditreia
[ (51t of prtos g i [Eware J[ o ]

To execute several instructions at the same breakpoint, select and edit an
instruction and click Insert. Repeat for several instructions.

To update parameter fields during method run, check the Auto update...
box.

To perform the instructions, click Execute.
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4.5 Method queue, Design of Experiments, Scouting and BufferPro runs

4.5 Method queue, Design of Experiments, Scouting and
BufferPro runs

Introduction

This section describes how to start method queues, Design of Experiment runs and
Scouting runs. Some preparations before a BufferPro run are also described.

Run Method queues

A method queue with a number of methods is created in the Method Editor. See UNICORN
Method Manual for information.

The following instruction describes how to start and monitor a method queue that was
created in the Method Editor.

Step Action

1 In the Method Navigator in System Control, select the method queue and
click the Run button.

> |

Method Mavigakor

) T
=T, u Methods, Method Cu

| Falder name Syskem
= [ MethadPackageSystems

eJAFFMethndQueue

[E]) Affrethods System 5
[} AffMethodz System 5
[ AffMethad1 System 5

2 Click to start Immediately, or At time.
Set Start Time and Run E]

Start queue (&) Immediately

() Ak time: r 51 | kb on | 003031

Result: The Start protocols will be displayed for all methods in the method
queue.

3 Navigate through the Start protocol as described in Navigate in the Start
protocol, on page 23. Click Start in the last page of the Start protocol.
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4.5 Method queue, Design of Experiments, Scouting and BufferPro runs

Step

4

Action

Select a column in the Select Columns dialog. See Column handling and
method start, on page 24.

Result: The run starts.

To view the status of the method queue, on the System menu, click Running
methods.

Running Methods @
System | System 5 ~| Comnectedin cortrol
Method Status StartCaondition Remark
1 AffMethod] queued Immediateh Part of method queue: Affethodlueue
2 | AftMethad2 queued nmedistely Part of mathad qu thodQusue
3 | Afftdett k- queued Immediately | Fart of method queve: AffMethodUueue

To cancel a method, or change method sequence, select the row of the
method and use the buttons below the table.

Run DoE or Scouting methods

Design of Experiments (DoE) and Scouting methods are created in the Method Editor.
See UNICORN Method Manual.

The following instruction describes how to start such a method.

38

Step
1

Action

Inthe Method Navigatorin System Control, select the Scouting/DoE protocol
and click the Run button.

B

“:" () Methods, Methad Qu + [Z]-
I Folder name System
= E MethodPackageSystemS

[ [poet System S
[4J AffMethodQueus
[1] affmethods System S
[E]| affmethad2 System S
[£]| affrethadi System S
ﬁ_l AffFlowScouting System 5

UNICORN 6.4 System Control Manual 29-0659-81 AB



Step

4 How to perform a run
4.5 Method queue, Design of Experiments, Scouting and BufferPro runs

Action

If a Scouting scheme was selected in the Start Protocol, the scheme is dis-
played. The Scouting parameters can be edited, but the changes will not
affect the method, only the run.

Start Protocol - System 5 - DOE1 3]
Sty puanete:
Methad Seitings. Fluatin
METHOD SETTINGS.... Linear gradicrt
Nun  Included  Tlow rate [sdfminl  Gradient length [Ektion] (CV]
1 = asm 008
z ] so00 1000
3 2000 0w
4 150 a0
5 20w nmw
(3 B 35w 200
T B smm 1]
| Selest Variables. | [ insed Aun || Seies. | [RemoveRun| | Cowar |
7] Heis ] [[Cmen |

o Click Next.

o Click Start in the last page of the Start protocol.

Select a column in the Select Columns dialog. See Column handling and
method start, on page 24.

Result: The run starts.

Run a BufferPro method

For information on how to create BufferPro methods, see UNICORN Method Manual.
BufferPro is a system specific function.

Step

Action

1

2

Prepare stock solutions according to the BufferPro Properties of the method.

Prepare the instrument for a BufferPro run according to the instrument's
user documentation.

Select the BufferPro method in the Method Navigator and click the Run
button.

Navigate through the Start protocol as described in Navigate in the Start
protocol, on page 23. Click Start in the last page of the Start protocol.
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4.5 Method queue, Design of Experiments, Scouting and BufferPro runs

Step Action

5 Select a column in the Select columns dialog. See Column handling and
method start, on page 24.

Result: The run starts.
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5 System Settings

5 System Settings

About this chapter

Each installed instrument has a set of default parameter values, called system settings.
The System Settings dialog in System Control is used to view and edit the system settings
for the currently selected instrument before the run is started. This chapter describes
how to edit the system settings.

Note: System settings depend on the instrument configuration. The system settings
shown in this section may differ from the settings that are applicable for your
specific instrument configuration.

Alternative paths for editing
System settings
The parameter values defined in System Settings are used as default values.

Some of the instructions listed in the system settings are also available as method and
manual instructions. When a runiis started, the parameter values from the system settings
are valid. If the same instruction is executed from the method or manually during a run,
the parameter value of the new setting will be valid. Thus, it is always the parameter
value of the instruction that was last executed that will be applied. When the run has
ended, the parameter values are reset according to the system settings.

The effect of changing the system settings depends on when it is performed, as described
in the table below. This section only describes settings available from the Settings menu
item on the System menu.
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5 System Settings

Edit System Settings

42

Follow the instruction to edit the System Settings.

Step

Action

1

In the System Control module, on the System menu. click Settings.

Result: The System settings dialog opens with the Instructions displayed.
The instructions in the menu differ depending on the specific system. See
examples of different menus below.

Instructions:
Alarm LV
Wavelength
Muoige reduction UV
Conductivity
pH
Pumps and pressures
Air sensor
Fraction collection
Watch parameters
Advanced
Data collection

or

Ingtructions:

Specials
Monitors
= Generic
Method behaviour
Data recowvery
Data collection

Select the instruction to edit from the list. Click the + symbol to show the in-
structions for each category. The instructions in each category differ depend-
ing on the system.

Select settings and choose parameter values for the selected instruction.
Minimum and maximum values for each parameter are shown within
brackets by each field. Click OK.

To return to the default values defined in the instrument configuration, click
Set Parameters To Strategy Default Values.

Note:

The System Settings are changed to new default values according to the above
instruction. If you manually change any of these values for a run in the Text
Instructions pane in Method Editor, or in the Manual Instructions dialog in
System Control, the changes only affect the current run.
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5 System Settings

Enable power-save
Follow the instructions to enable power-save for the instrument.

Note: Power-save is a instrument specific functionality.

Step Action

1 In the System Control module, on the System menu, click Settings.
Result: The System Settings dialog opens.

e Select Advanced
and

e select Power-save

System Settings - Akta Pure w

Instructions:

— F for Powersave
[ Air sensor = Mode
& 1/0-box R .
& Fraction collection @ Off ©0n
[# Tubing and Delay volumes - e [10 - 1440]
= Wash settings e
[ Watch parameters 60 2min
i=| Advanced
f
Instrument control panel
Pressure control parameters
Constant pressure flow parameters —
Max flow during valve tum -

[ Set Parameters To Stretegy Default Values | [ 0K | [ Cancel

= — =

r=

3 o Click On in the Mode field
and

e enter the number of minutes in the Time field.

Note:

This is the time the instrument will be in state Ready before power-save
mode is entered.

o Click OK.
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6 Troubleshooting

About this chapter

This chapter describes different operational scenarios which may arise in UNICORN, and
how to solve the problems or consequences.

Tip:

For additional advice concerning operational scenarios and possible solutions,

refer to the UNICORN Information Letter. The UNICORN Information Letters
are available at www.gelifesciences.com/unicorn.

In this chapter

This chapter describes the following scenarios:

User access problems

Unable to access UNICORN functions

Unable to connect or locate chromatography systems or workstations

A displayed error message or alarm is incomprehensible

User Access

Problem description

Username and password not
accepted.

Solution ‘

The UNICORN administrator should check if the
user account is locked, for example after too many
unsuccessful log on attempts.

The UNICORN administrator can try to set a new
password.

If a password reset does not work, the user profile
may have to be deleted and a new profile created.

The log on dialog is inactive
and a password cannot be
entered.

Verify that no UNICORN window or module is
opened.

Log off from Windows and log on again.

44
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6 Troubleshooting

Access to UNICORN functions

Problem description Solution

The Execute manual instruction menu
command in the System Control module
is dimmed, that is you can establish a
connection but cannot control the sys-
tem.

e Check that no other user has a con-
trol mode connection.

e Checkthatyou have access rights to
control the system manually.

The help viewer cannot be opened using
help buttons or the F1 key.

1 Open the MadCap help viewer from
the Windows desktop icon. This is
described in UNICORN Administration
and Technical Manual.

2 Try the help button or F1 key again.

The Microsoft® Office Document Image
Writer causes UNICORN to terminate.

An error message is shown when a run
is started, stating that not enough disc
space is available.

This writer application will not work.
Choose another option, for example a
PDF writer application.

1 GB of free disc space is required as
headroom before a run can be started,
to ensure that all data can be accommo-
dated.

A user without access to the function
Method Pause may still pause a method
using a Timer instruction.

A user without access to the function
Method End may still pause a method
using a Timer instruction.

Access to the Timer instruction must also
be disabled if users are not allowed ac-
cess to the Method Pause function.

Access to the Timer instruction must also
be disabled if users are not allowed ac-
cess to the Method End function.

A manual run is started. A method run is
then started and a start protocol opens.
Before the start protocol is finished, an
alarm is caused by the manual run. The
start protocol cannot be completed and
the method run cannot start at this point.
This is because the alarm must be ac-
knowledged first, but no message about
this is issued.

Either stop the manual run which will al-
low the method run to start, or start an-
other method. This will add the second
method to the list of running methods
and the first method is allowed to start.
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System connections

Problem description

The connections are not available,
i.e. the selection check box is
dimmed.

Solution ‘

Check if the chromatography system has
been deactivated.

Check that the power to the chromatogra-
phy system is turned on.

Check the connection between the PC and
the chromatography system.

The connections are not available
even though

e the connection between the
PC and chromatography sys-
tem appears to be correct

e the power is turned on.

Switch off the chromatography system.
Exit UNICORN.

Shut down the instrument server computer.
Restart the chromatography system.
Restart the instrument server computer.

Log on to UNICORN.

Asystem is not available when you
attempt to establish a connection.

Check that you have access rights to the
system. Access rights are not automatically
assigned for a newly defined system.

The system may not be active.

Log off and log on again for access rights
changes to be applied.

You receive the error message
“Cannot connect to system...” in
a network installation.

Check that the local computer to which the
system is connected is turned on and
logged on to the network.

Check that the computer from which you
try to establish a connection is logged on
to the network.

Check that the limit of five simultaneous
connections to the system has not been
exceeded.
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Problem description ‘ Solution

You receive the error message This error message is displayed if a system is
"Warning, system occupied" when | defined and active in two different database
trying to connect. instances and is already connected in the other

instance. It is not recommended to have a sys-
tem defined and active in more than one
database instance.

You are connectedtoasystembut | o Check that the instrument is turned on.
have no contact with the instru-
ment. The system hangs at initial- = ® Checkthatall cable connections are intact.

ization. e Checkthatthe systemis configured correct-

ly, in System Properties and on the instru-
ment display.

« If the above actions do not help, try to
restart both the instrument server computer
and the instrument.

When attempting to connecttoan | Ensure that all client computer installations are
instrument server, an error mes- compatible with the instrument configurations
sage is displayed stating that the | used.

client connecting and the instru-
ment server are incompatible. In
fact, itis the current instrument
configuration which is incompati-
ble with the client UNICORN instal-
lation.

Error messages and alarms

If a displayed error message or alarm is incomprehensible, contact your local GE repre-
sentative.
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